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Product Information

The STM32F103C8T6 ARM STM32 Minimum System Development Board Module is a development board that is
based on the STM32F103C8T6 microcontroller. It is designed to be programmed using the Arduino IDE and is
compatible with various Arduino clones, variations, and third-party boards like the ESP32 and ESP8266.

The board, also known as the Blue Pill Board, operates at a frequency approximately 4.5 times higher than an
Arduino UNO. It can be used for various projects and can be connected to peripherals such as TFT displays.

The required components to build projects with this board include the STM32 Board, FTDI Programmer, Color
TFT display, Push Button, Small Breadboard, Wires, Power Bank (optional for stand-alone mode), and USB to
Serial Converter.

Schematic

To connect the STM32F1 board to the 1.8 ST7735-based coloured TFT Display and a push button, follow the pin-
to-pin connections described in the provided schematics.

Setting up the Arduino IDE for STM32

1. Open the Arduino IDE.

2. Go to Tools -> Board -> Board Manager.

3. In the dialogue box with a search bar, search for “STM32F1” and install the corresponding package.
4. Wait for the installation procedure to complete.

5. After installation, the STM32 board should now be available for selection under the Arduino IDE board list.



Programming STM32 boards with the Arduino IDE

Since its inception, the Arduino IDE has demonstrated the desire to support all kinds of platforms, from Arduino
clones and variations of different manufacturers to third-party boards like the ESP32 and ESp8266. As more
people get familiar with the IDE, they are beginning to support more boards that are not based on ATMEL chips
and for today’s tutorial we will look at one of such boards. We will examine how to program the STM32-based,
STM32F103C8T6 development board with the Arduino IDE.
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Blue Pill Board

The STM32 board to be used for this tutorial is none other than the STM32F103C8T6 chip-based STM32F1
development board commonly referred to as “Blue Pill” in line with the blue colour of its PCB. Blue Pill is powered
by the powerful 32-bit STM32F103C8T6 ARM processor, clocked at 72MHz. The board operates on 3.3v logic
levels but its GPIO pins have been tested to be 5v tolerant. While it does not come with WiFi or Bluetooth like the
ESP32 and Arduino variants, it offers 20KB of RAM and 64KB of flash memory which makes it adequate for large
projects. It also possesses 37 GPIO pins, 10 of which can be used for Analog sensors since they have ADC
enabled, along with others that are enabled for SPI, 12C, CAN, UART, and DMA. For a board that costs around $3,
you will agree with me that these are impressive specs. A summarized version of these specifications compared
with that of an Arduino Uno is shown in the image below.



Number of Cores 1 1
Architecture 32 Bit 8 Bit
CPU Frequency 72 MHz 16 MHz
WiFi NO NO
BLUETOOTH NO NO
RAM 20 KB 2 KB
FLASH 64 KB 32 KB
GPIO PINS 37 14
Busses SPI, 12C, UART, SPI, 12C, UART
CAN
ADC Pins 10 6
DACPins 0 0

Blue Pill Board

Based on the specs above, the frequency at which Blue Pill operates is about 4.5 times higher than an Arduino
UNO, for today’s tutorial, as an example on how to use the STM32F1 board, we will connect itto a 1.44" TFT
display and program it to calculate the “Pi” constant. We will note how long it took the board to obtain the value an
compare it with the time it takes an Arduino Uno to perform the same task.

Required Components

The following components are required to build this project;

« STM32 Board

o FTDI Programmer
o Colour TFT

o Push Button

o Small Breadboard
o Wires

» Power Bank

« USB to Serial Converter

As usual, all the components used for this tutorial can be bought from the attached links. The power bank is
however only needed if you want to deploy the project in a stand-alone mode.

Schematic

« As mentioned earlier, we will connect the STM32F1 board to the 1.8" ST7735 based coloured TFT Display

along with a push button.

« The push button will be used to instruct the board to start the calculation.



« Connect the components as shown in the schematic below.
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To make the connections easy to replicate, the pin-to-pin connections between the STM32 and the display is
described below.

STM32 - ST7735

BV - VCC
GND - 6ND
PA2 - CS
PA3 - DC
PA4 - RST
PADS - SCK
PA7 - SDA
3.3V - LED

Go over the connections once again to be sure everything is as it should be as it tends to get a little bit tricky. With
this done, we proceeded to set up the STM32 board to be programmed with the Arduino IDE.

Setting up the Arduino IDE for STM32

« As with most boards not made by Arduino, a bit of setup needs to be done before the board can be used with
the Arduino IDE.

« This involves installing the board file either via the Arduino Board Manager or downloading from the internet
and copying the files into the hardware folder.

« The Board Manager route is the less tedious one and since the STM32F1 is among the listed boards, we will
go that route. Start by adding the link for the STM32 board to the Arduino preference lists.

« Go to File -> Preferences, then enter this URL (



http://dan.drown.org/stm32duino/package _STM32duino_index.json ) in the box as indic
click ok.

ated below and

Network
Sketchbook location:

JUsers /femmaodunlade/Documents /Arduino Browse
Editor language: System Default & (requires restart of Arduino)
Editor font size: 12
Interface scale: v Automatic 100 ©% (requires restart of Arduino)

Theme: Default theme T  (requires restart of Arduino)
] @ Additional Boards Manager URLs
Show verbose output during: ¢ = -
) Enter additional URLs, one for each row
EOmBHRE WA M htlps Jrdl. espressif com/dl/package_esp32_index.json |
i : |
Risplay ftie auebers http://dan.drown.org/stm32duino/package_5TM32duino_ |ndex150n| 2 |
Enable Code Folding
+ Verify code after upload |
Use external editor Click for a list of unofficial boards support URLs 3 |
Aggressively cache compiled ¢ I oK Cancel |

Check for updates on startup
Update sketch files to new extension on save (.pde -> .ino)
Save when verifying or uploading

S8 (K118

1
Additional Boards Manager URLs: https://dl.espressif.com/dl/package_esp32_index.json,http://arduino.esp82 | [ =

Maore preferences can be edited directly in the file
fUsers femmaodunlade/Library/Arduinol5fpreferences.txt

(edit only when Arduino is not running) 4

=]

Cancel

« Now go to Tools -> Board -> Board Manager, it will open a dialogue box with a search bar. Search for

STM32F1 and install the corresponding package.


http://dan.drown.org/stm32duino/package_STM32duino_index.json

" ® Boards Manager

Type All B s™

| sTM32 Discovery F407, STM32F4Stamp F405, Netduine2 F405,
Online help
More info

STM32F3xx boards by stm32duine
Boards included In this package:
STM32F3DIscovery.

Online help

More |nfo

STM32F1xx/GD32F1xx boards by stm32duino

Boards included in this package:

Maple Mini, Maple (Rev 3), Maple {(RETG), Micreduino Core STM32 to Flash, STM Nucleo F103REB (STLink), Generic STM32F103C serles, Generic
STM32F103R serles, Generic STM32F 103T series, Generic STM32F 103V series, Generlc STM32F103Z series, Generic GD32F103C serles.

Online help

More info

2019629 [ | Instal

Close

« The installation procedure will take a few seconds. After that, the board should now be available for selection
under the Arduino IDE board list.

Code

» The code will be written the same way we’d write any other sketch for an Arduino project, with the only
difference being the way the pins are referenced.

« To be able to easily develop the code for this project, we will use two libraries which are both modifications of
standard Arduino Libraries to make them compatible with the STM32.

« We will use the modified version of the Adafruit GFX and the Adafruit ST7735 libraries.

» Both libraries can be downloaded via the links attached to them. As usual, | will be doing a short breakdown of
the code.

« We start the code by importing the two libraries that we will use.

AS h

£ o [l

STM3Z /tree/master/STM32F]1 /1librarie

#includs "Adafruit ST7735.h" // https://github.com/KenjutsuGH/Adafruit-ST7735-
Library

« Next, we define the pins of the STM32 to which the CS, RST, and DC pins of the LCD are connected.

#define cs PRZ2
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« Next, we create some colour definitions to make it easy to use colours by their names in the code later instead

of by their hex values.

fdefine BLACK 0x0000
#define BLUE Ox001F
fdefine REL OxF80C
fdefine GREEN Ox07E

fdefine CYAN 0x0TFFE
fdefine MAGENTA xF1F
fdefine YELLOCE < EFE

fdefine WHITE 0xFEFE

« Next, we set the number of iterations we want the board to go through along with the refresh duration for the

progress bar to be used.

« With this done, we create an object of the ST7735 library which will be used to reference the display
throughout the entire project.
« We also indicate the pin of the STM32 to which the pushbutton is connected and create a variable to hold its

state.
Adafruit ST7735 tft = Bdafruit ST7735(cs, dc, rst);
int percent =

const int buttenPin = PBY9;

« With this done, we move to the void setup() function.
« We start by setting the pinMode() of the pin to which the pushbutton is connected, activating an internal pull-up

resistor on the pin since the pushbutton connects to the ground when pressed.



voild setup(void) {

pinMode (buttonPin, INPUT PULLUP) ;

« Next, we initialize serial communication and the screen, setting the background of the display to black and

calling the print () function to display the interface.

Serial .begin(9600) ;
tft.initR (INITR BLACKTAB) ; f/ initialize a ST77355 chip, black tab
tft.fillScreen (ST7735 BLACRK) ;

printlUI();

« Next is the void loop() function. The void loop function is quite simple and short, thanks to the use of
libraries/functions.

« We start by reading the state of the push button. If the button has been pressed, we remove the current
message on the screen using the removePressKeyText() and draw the changing progress bar using the
drawBar() function.

« We then call the start calculation function to obtain and display the value of Pi along with the time it took to

calculate it.

vold loo ) {
butt tate = digitalRead (buttonPin);
if (buttonState == ACTIVATED



« If the pushbutton is not pressed, the device stays in ldle mode with the screen demanding that a key be

pressed to interact with it.

o Finally, a delay is inserted at the end of the loop to give a bit of time before sketching “loops”.

(1]

ay (10) ;

d=l

&

« The remaining part of the code is the functions called to achieve the tasks from drawing the bar to calculating
the Pi.
« Most of these functions have been covered in several other tutorials that involve the use of the ST7735 display.

id fillBar (int percent)
int counter =&l
percent = map(percent,0,100,5,121);
for {counter = &0; unter<]5;counter++
tft.drawFastHLine (5, nter, ercent, YELLOW );
1d rintUT ()
tft.setCursor 1, 5)

tft.setTextColor (RED) ;

tft.setTextSize(l);

Hh

tft.print ("PI BENCHMARK") ;



tft.setCursor (30, 60) ;
tft.setTextColor (WHITE) ;
tft.setTextSize (1)

tft.print ("PRESS KEY"):

tft.setCursor (5,120) ;
tft.setTextColor (RED) ;
tft.setTextSize (1);

EEEoprant (PRI )

tft.setCursor(5,140);
tft.setTextColor (RED) ;
tft.setTextSize (1) ;

Lt print{"TIME-™);

void removePressKeyText ()

tft.setCursor (30, 60) ;

tft.setTextColor (BLACE) ;

tft.setTextSize (1) ;

tft.print ("PRESS KEY");

volid drawBar ()

tft.drawRect (5,60,120,15, YELLOW):



void startCalculation()

unsigned long start, time;
unsigned long niter=ITERATIONS;
int LEDcounter = 0;

unsigned long i;

float = = 1.07

float pa=1.0;

Serial .begin(9600) ;
Serial.print ("Beginning "} ;
Serial .print (niter);

v

Serial.println(" iterations...™);

Serial.println();

start = millis():

for {( i = 2; 1 < niter; 1++) |
e L
pi += x [/ (2.0f*(float)i-1.0f};

if {(LEDcounter++ > REFRESH TET) |

LEDcounter = 0;
pProgresst+;
percent = progress*100/ (ITERATIONS/ REFRESH TFT);

fillBar (percent);

time = millis{) = start;

pi =pi * 4.0;



Serial.print("# of trials = ");

Serial .println(niter};

Serial.print ("Estimate of pi = "):
String piString = String(pi,7):

String timeString = String(time)+"ms";

Serial .println{piString)};

Serial .print ("Time: "); Serial.print{time); Serial.println(" ms");

tft.setCursor (40,120} ;
tft.setTextColor (GREEN) ;
tft.setPextsSize (1) ;

tft.print {(piString) ;

tft.setCursor (40,140} ;
tft.setTextColor (GREEN) ;
tft.setTextSize (1) ;

tft.print{timeString);

« The complete code for the project is available below and is attached under the download section.

#include <Adafruit GFX AS.h>
{/https://github.com/rogerclarkmelbourne /Arduino STM3Z/tree/master/STM32F]1/librarie
s/Adafruit GFX AS

#include "Adafruit ST7735.h" // https://github.com/EenjutsuGH/Adafruit-ST7735-
Library

//Please note that you need to delete the Adafruit ST7735 library for Arduino if
you have it installed, else the

//sketch won't compile.



#define rst PA4

#define dc PR3

// Color definitions

#define BLACK 0x0000
#define BLUE 0x001F
#define RED O=xF800
#define GREEN 0=z07ED
#define CYAN Ox07FF

#define MAGENTA OxFBI1F

#define YELLOW 0xFFEQ

#define WHITE 0XFFFF
#define ITERATIONS 500000L [/ number of iterations
fdefine REFRESH TFT 7500 // refresh bar ewvery 7500 iterations

#define ACTIVATED LOW

#if defined( SAM3XBE )
#undef FlashStringHelper::F(string literal)
#define F(string literal) string literal

#endif

Adafruit ST7735 tft = Bdafruit 8T71735{cs, dc, rst):

int percent = 0;

int pregress = 1;

const int buttonPin = PBEY9;



int buttonState = 0;

void setup(void) [

pinMode (buttonPin, INPUT PULLUP);

Serial _begin(9600) ;

tft.initR (INITR BLACKTAR) ; //f initialize a ST7735S8 chip, black tab

tft.fillScreen(ST7735 BLACK);

printUi();

void lecp() |

buttonState = digitalRead (buttonPin);
if (buttonState = ACTIVATED) {
removePressKeyText ()
drawBar () ;

startCalculation();

else |

delay(10) ;



void fillBar (int percent)

int counter =60;
percent = map(percent,0,100,5,121);

for (counter = &0; counter<75;counter++)

tft.drawFastHLine (5, counter, percent, YELLOW };

void printUI ()

tEEisetCursor (30,57
tft.setTextColoxr (RED) 5
tft.setTextS8ize (1) ;

tft.print ("PI BENCHMARK") ;

tft.setCursor(30,60);
tft.setTextColoxr (WHITE) ;
tft.setText8ize(l);

tft.print ("PRESS KEY"):

tft.setCursor (5,120);
tft.setTextColor (RED) ;
tft.setTextSize (1) ;

tEC.print{"PE:"}:

tft.setCursor (5,140);



tft.setTextColor (RED) ;
tft. setPextsize (1) ;

tft. print{"TIME:") ;

void removePressKeyText ()

tft.setCursor (30, 60);
tft.setTextColor (BLACE) ;
tft.setTextSize (1)

tft.print ("PRESS KEY") ;

void drawBar ()

tft.drawRect (5,60,120,15, YELLOW);

void startCalculation()

unsigned long start, time;
unsigned long niter=ITERATIONS;
int LEDcounter = 0;

unsigned long i;

float == 1.07

float pi=1.0;

Serial .begin(9600) ;

Serial .print ("Beginning "};



Serial .print (niter) ;
Serial .println(" iterations...");

Serial.printlin{(};

start = millis(};
for { 1 = 2; 1 € miter; att) |
xik= —F o0
pi += = / (2.0f* (fleat)i-1.0f);
if (LEDcounter++ > REFRESH TET) |
LEDcounter = 0;
progresst+;
percent = progress*100/(ITERATIONS/ REFRESH TFT);

fillBar (percent);

time = millis() - start;

pi=pi* 4.0;

Serial .print("# of trials = ");
Serial.println(niter):;

Serial .print ("Estimate of pi = ");
String piString = String(pi,7);

String timeString = String(time)+"ms";

Serial .println (piString);

Serial ..print("Time: "); Serial.print(time); Serial.println("™ ms");

tft.setCursor (40,120) ;



tft.setTextColor (GREEN) ;

tft.setPextsSize (1) :;

tft.setCursor(40,140);
ft.setTextColor (GREEN) ;
tft.setTextSize (1)

tft.print(timeString);

Uploading Code to the STM32

» Uploading sketches to the STM32f1 is a little bit complex compared to standard Arduino-compatible boards. To
upload code to the board, we need an FTDI-based, USB-to Serial converter.

« Connect the USB to serial converter to the STM32 as shown in the schematics below.
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Connect FTDI to STM32

Here is a pin-to-pin map of the connection

FTDI - STM32

« With this done, we then change the position of the board’s state jumper to position one (as shown in the gif
below), to put the board in programming mode.
« Press the reset button on the board once after this and we are ready to upload the code.
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« On the computer, ensure you select “Generic STM32F103C board” and select serial for the upload method
after which you can hit the upload button.

Tools Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Manage Libraries...
Serial Monitor

Serial Plotter

WIiFi101 [/ WIFiNINA Firmware Updater

Board: "Generic STM32F103T series"

Variant: "STM32F103T8 (20k RAM. 64k Flash)"
Upload method: "Serial"

CPU Speed(MHz): "72Mhz (Normal)"

Optimize: "Smallest (default)"

Port

Get Board Info

Programmer: "AVRISP mkill"
Burn Bootloader

Select the board and set upload method to serial

« Once the Upload is complete, change the state jumper to position “O” This will put the board in “run” mode and



it should now start running based on the code uploaded.
« At this point, you can disconnect the FTDI and power the board over its USB. In case the code does not run

after powering, ensure you have restored the jumper properly and recycle power to the board.

Demo

« With the code complete, follow the upload process described above to upload the code to your setup.

¢ You should see the display come up as shown in the image below.

o Press the push button to start the calculation. You should see the progress bar slide gradually until the end.

« At the end of the process, the value of Pi is displayed along with the time which the calculation took.
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« The same code is implemented on an Arduino Uno. The result is shown in the image below.



Arduine Speed Test

« Comparing these two values, we see that “Blue Pill” is over 7 times faster than the Arduino Uno.
« This makes it ideal for projects which involve heavy processing and time constraints.
« The small size of the Blue Pill also serves as an advantage here as it is only a bit bigger than the Arduino Nano

and it can be used in places where the Nano won'’t be fast enough.
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